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Description 

Description 

  
Explanation of terms OPC stands for “OLE for Process Control”. It is a standardized data communication in-

terface based on the Microsoft Windows OLE/DCOM technology. The AO-OPC OPC 
server operates with all OPC clients (data access). 

Further information about OPC is available on the Internet at  
https://opcfoundation.org/. 

  
Network structure 

 

  
AO-OPC OPC server The OPC DA server AO-OPC is a standard software interface to the Advance Optima 

AO2000 Series gas analyzers (all software versions).  

The OPC server can also communicate with any SCADA, DCS or PLC system which has 
an OPC client (data access). 

The OPC server runs on the computer as a service, i.e. invisible in the background. 

  
Connection with several 
gas analyzers 

It is possible to establish connections to several gas analyzers with different software 
versions from one OPC application at the same time.  

Data of the individual gas analyzers can be displayed in the diagnostics window of the 
AO-OPC remote control. 

  
AO-OPC remote control AO-OPC remote control is used to configure a local OPC server (running on the same 

computer) as well as to configure an OPC server running on another computer con-
nected to the local network. 
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Read access The OPC server makes the most important data from the gas analyzer available for fur-
ther processing. Details can be found under data tag descriptions (see page 25). The 
data that can be read from the gas analyzers include the following: 

 Analyzer data, connection status and general data, 
 Diagnostic/status information such as failure, maintenance request, maintenance 

mode, 
 Measured values, 
 Values of the analog inputs and outputs, 
 Status of the digital inputs and outputs, 
 Auxiliary variables such as detector temperature or flow rate, 
 Values for zero drift and span drift. 

  
Write access In addition to read-only access via the OPC server, write access to the gas analyzer’s 

control inputs is also possible. In conjunction with a function block configuration many 
different functions can thus be executed using the Ethernet interface, e.g.: 

 Starting automatic calibration 
 Switching measuring ranges. 

  
Redundant  
Ethernet lines 

A redundant link between the gas analyzer and the AO-OPC OPC server can be created 
by configuring a second Ethernet line (see figure “Network Structure” on page 3). Both 
Ethernet lines are monitored continuously. If one line fails, the system switches over to 
the redundant line. 

Note:  
In this case, a second network card must be built-in in the gas analyzer as well as in the 
computer on which the OPC server is installed. 

  
Recommendation for 
the installation 

The OPC server and OPC client(s) may in principle be installed on separate computers. 
However, the DCOM method used is more difficult to configure and more sensitive to 
faults on the connection than is the COM method which is used when the OPC server 
and OPC client(s) are installed on the same computer. We recommend in general that 
you install the OPC server and OPC client(s) on the same computer. 
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Installation 

Installing and uninstalling AO-OPC 

  
System requirements  Operating system:  

Windows 7 (32-bit), Windows 7 (64-bit)  
Windows 8.1 (32-bit), Windows 8.1 (64-bit)  
Windows 10 (32-bit), Windows 10 (64-bit)  
Windows Server 2008 R2  
Windows Server 2012 R2  
Windows Server 2016 

 Network card (and 2nd network card for redundancy operation) configured under 
Windows with TCP/IP 

 Administrator rights on the computer are required for installation. 

  

 
Before installing AO-OPC you must uninstall an already existing older version of AO-OPC.

  
Installing AO-OPC Step Action 

1 Insert CD-ROM containing the AO-OPC program in the drive. 

2 Run “ao_opc_x_y_z.exe”. 

“x_y_z” corresponds to the current program version. 

3 Follow the instructions in the installation program. 

 
The installation program will propose installing AO-OPC in the “Ana-
lyze IT” folder; this can simply be accepted. All the Analyze IT soft-
ware tools are installed in this folder by default. 

  
Uninstalling AO-OPC Step Action 

1 Shut down service (see page 8). 

2 Deregister by AO-OPC remote control (see page 7). 

 
If not, several entries will remain in the Windows Registry. 

3 Uninstall the AO-OPC software. 

 
To do this, use the icon “Software” in the control panel. 
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Configuration 

First steps 

  
Remote control All steps required for configuration can be made by "AO-OPC Remote Control". The re-

mote control is used to configure a local OPC server (running on the same computer) as 
well as to configure an OPC server running on another computer in the local network. 

  
Starting remote control To run the remote control call "AO-OPC Remote Control" from "Start → Programs → An-

alyze IT → AO-OPC". 

  
 

 

  
Password In order to change the settings, you have to log in with the appropriate password. The 

corresponding dialog is opened via the menu "Options → Access password". 

  
Password levels Password Access Rights 

325465 User has all rights. 

081500 User can configure connections. 

No or faulty entry User has the right to connect to one gas analyzer and view the 
values 
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Settings 

Settings The settings can only be made locally on the computer on which the program "AO-OPC 
Remote Control" is called. Clicking on the menu "Options → Settings" opens the corre-
sponding dialog. 

Only users with administrator rights can access the menu. 

  
Registration 

 

  
Setting the registration  “The AO-OPC server is to run as service.”  

If the server is running, it is shut down on request. The registration of the server will 
be done as “Service”. If necessary, the server is restarted on request. 

 Start type “Manual”: The service is not automatically started upon starting the 
computer, but has to be started via “Settings → Control Panel → Administrative 
Tools → Services → OptimaOPCService”. An OPC client connecting with the OPC 
server can also start the server, if the DCOM-settings permit this. 

 Start type “Automatic”: When the computer is started, the service is automatically 
started. In this case, there is no need for a user to be logged in. 

 “The AO-OPC server is to be deregistered.”  
If the server is running, it is shut down on request.  

 

The server is deregistered. A deregistered OPC server can no longer be started by an 
OPC client. 

  

 
 While you are setting the registration, no Services Control Panel should be opened, 

because otherwise the values shown in this Control Panel and in the AO-OPC dialog 
Registration might be faulty. 

 Any change in the registration of the OPC server will cause a reset of the DCOM set-
tings for the application Optima OPC Service. As a result, you possibly need a new 
permission for an access by a remote OPC client. 
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Permissions for remote 
control 

 

  
Setting the permissions 
for remote control 

 Remote control of the OPC server is permitted from all PCs of the local network. 

 The OPC server may only be remote-controlled from the PC on which it has been in-
stalled. 

 Remote control of the AO-OPC server is not allowed at all. 

 Port: Indicates the port number used for remote control by the OPC server. 

  
Starting the  
OPC server 

Having confirmed the settings with "Ok", you will see the following request: 

 

"Yes" The OPC server is started at once. 

"No" The OPC server can be started later. 

  
Stopping the 
OPC server 

Proceed as follows to stop the OPC server: 

Open "Settings → Control Panel → Administrative Tools → Services", select "Optima 
OPC Service" and click on the "Stop" command in the popup menu. 
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Configuring connections 

Configuring connec-
tions 

Connections can be configured in online or offline mode. If the connection to a server 
is made via "Service Remote Control", you are in online mode. In this case the connec-
tion configurations affect the server to which you are connected. In offline mode, the 
configurations are made for the computer on which the remote control is running. 

The menu options "File → Connect…" and "File → Remove Connection…" are only avail-
able in online mode. 

  
Add 
AO2000 connection 

 

  
 The dialog can be opened via the menu "File → Connect…" (only in online mode).  

A unique AO2000-Reference-Number, a Hostname and an Update Rate must be en-
tered. The Backup Hostname is optional. 

  
Remove 
AO2000 connection 

 

  
 With "File → Remove Connection…" you can remove an existing connection (only in 

online mode). Choose the AO2000 Reference name of the connection which is to be re-
moved. The other dialog fields show details of the currently selected reference name. 
The connection is deleted by closing the window with "Ok". 
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AO2000  
connection manager 

 

  
 Click on "File → Connection Manager" to open the above window which makes it possi-

ble to manage all connections at a glance. Using the drag&drop function you can move 
connections from the "Actual Configuration" to the "New Configuration" to edit them 
comfortably there. 

By clicking the right mouse key in the list "New Configuration" a pop-up menu with the 
following menu options will appear: 

"Add" Adds a new entry to the configuration. 

"Edit" Edits the configuration of the currently selected entry. 

"Delete" Deletes the currently selected entry. 

Closing the window with "Ok" saves the new configuration. In offline mode this is done 
by overwriting the INI file of the OPC server, in online mode by remote control of the 
corresponding OPC server. 
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Configuring remote control 

Remote control Using the remote control you can connect to any OPC server in the network that has 
been enabled for remote control. 

Remote control makes it possible to view the tags of the server and – with the appro-
priate password – to configure the connections. 

  
Service remote control 

 

  
 Click the menu option "Service → Remote control…" to open the dialog. 

 Control service on a network computer  
If this option is enabled and the dialog is exited with "Ok", the remote control tries to 
connect to the OPC server running on the computer of which the IP address or server 
name has been entered.  
If this option is disabled and the dialog is exited by pressing "Ok", the remote control 
tries to connect to a locally installed OPC server. 

 IP address 
IP address of the computer on which the OPC server to be connected to is running. 

 Server name 
Server name of the computer on which the OPC server to be connected to is running. 

 Port 
Port number of the port to which the socket is connected. Needs to be the same as 
selected on the computer running the OPC-Server at "Options → Settings… → Per-
missions for remote control". 

  
End remote control Select the menu option "Service → End Remote Control". The remote control is stopped 

and the contents removed from the window. 
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DCOM configuration 

Modifying the DCOM 
settings of Windows 

The DCOM settings of Windows must be customized, so that an OPC client can con-
nect to the AO-OPC server.  

The following description is based on the Windows 7 default configuration with Ser-
vice Pack 1 installed. 

  

 
You require administrator rights to execute the following actions. 

  
1 Click the Windows Start button and type “dcomcnfg” in the Search line. 

“dcomcnfg.exe” should appear in the top part of the box as a search result.  

Click “dcomcnfg.exe” to start the program. 

 

If you have sufficient rights, the following box will open. 

 



 AO-OPC OPC SERVER  |  OI/AO-OPC-EN REV. A 13

 

2 Double-click to expand the “Component Services” and the “Computers” folders. (Al-
ready expanded in the above figure) Right-click “My Computer” and then click “Proper-
ties”. 

  
3 Click to select the “Default Properties” tab. 

 

 

  
4 Check your display against the settings and make changes to your settings if required. 

  
5 Click to select the “COM Security” tab. 
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6 Add the two system objects “SYSTEM” and “INTERACTIVE” (unless already added) in 
“Access Permissions → Edit Default…” and in “Launch and Activation Permissions → 
Edit Default…”. 

7 Add the objects “SYSTEM” and “INTERACTIVE” with local Launch, Access and Activation 
Permissions set. If you plan to launch or poll the AO OPC server from a remote OPC cli-
ent, also enable the remote permissions (Remote Launch, Remote Activation and Re-
mote Access) for the above objects. 

 

  

  
8 To add an object, click “Add…” and enter the respective object name in the following 

box. 

  
9 Exit the selection dialogs with “OK”. If a warning box appears, confirm it with “OK”. 

  
10 If you plan to run the AO-OPC server, an OPC client and the AO2000 OPC remote con-

trol on the same computer, you do not need to make any further settings. However, 
please read the section “Completing the configuration and important information” 
(see page 23). 

If you only wish to use the AO2000 OPC Remote Control from a remote computer, then 
you also have to enable the port for remote control (normally 9531) in the Windows Fire-
wall. This is carried out in the same way as in the subsequent description for the DCOM 
port with a remote OPC client. Name: OPC Remote Control / port number: 9531 / TCP.  

If you plan to launch or poll the AO OPC server from a remote OPC client, you do not 
need to enable the port, since the complete AO-OPC server application then has to be 
enabled in the Windows Firewall (see page 18). 
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11 If you plan to launch or poll the AO OPC server from a remote OPC client, you have to 
make some further settings in the Component Services and possibly in the Windows 
Firewall. Furthermore, all the settings have to be implemented on the AO-OPC server 
computer and the OPC client computer (also the previous settings for “COM Security / 
Edit Default…”). 

The “Edit Limits…” buttons can be found under the “COM Security” tab (“dcomcnfg → 
Component Services → Computers → My Computer → Properties”, see above) under “Ac-
cess Permissions” and “Launch and Activation Permissions”. The subsequent remote 
permissions are added there: 

 On the OPC server and  
the OPC client computer:  
ANONYMOUS LOGON:  
Allow Remote Access. 

Only on the OPC server computer:  
 
Everyone: Allow Remote Launch and Allow 
Remote Activation 

 

  

  
12 The other permissions do not have to be set under “Default Security” of “My Computer”, 

but can be specifically set for the “Optima OPC Service” under “DCOM Config”.  

Settings for the “OPCEnum” service also have to be made. 

  
13 All users who wish to access the AO-OPC server from a remote OPC client should be 

known to the Windows user management on the OPC server computer. As an alterna-
tive, you can also use the object “Everyone” for the permissions; this gives access per-
missions to all known users. “Known users” means having a user with the same user 
name and matching passwords on the OPC server computer and on the OPC client 
computer. Empty passwords are not allowed for users that should get access to the 
OPC server. The use of “Everyone” is generally advised against for security reasons. De-
fine users and groups of the users who should have access to the OPC server in the 
Windows user management. 
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14 Choose the item “Optima OPC Service” from the “Component Services” window under 
“Computers → My Computer → DCOM Config”. 

 

  
15 Right-click to open the “Properties” dialog. 
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16 Set “Customize” in “Launch and Activation Permissions” and “Access Permissions” and 
click “Edit”. You obtain the security dialogs in the same way as for the “Default Secu-
rity” dialogs above. 

 

  

  
17 Click “Add” and select the users and/or groups who should have access from a remote 

OPC client in the following dialog. 

You can also select “Everyone” here (not recommended, see above) or the object 
“NETWORK”. The latter also gives all known users access permissions, but is restricted 
to users from remote computers. 

Ensure that the remote permissions (Remote Launch, Remote Activation and Remote 
Access) are enabled for the selected objects. 

  
18 You must also carry out the same actions for the “OPCEnum” service. 

This action must also be carried out for the “OPCEnum” service on the computer, on 
which the OPC client is running. These settings are also to be made for the OPC client 
if the OPC client is also a service (i.e. not a normal application). 

  
19 Exit the “Component Services” dialog. 
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Configuration of the 
Windows firewall 

The Windows firewall is exception-based, i.e. you have to except the requisite ports or 
applications from the blockade. 

If you disable the firewall completely, you do not need to make any further settings. 
Otherwise proceed as described below. 

  
1 Open the “Windows Firewall with Advanced Security” window via “Control Panel → Sys-

tem and Security → Administrative Tools”. 

The firewall is normally active. 
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2 Click “Inbound Rules” in the left-hand pane, then “New Rule…” in the right-hand pane. 

 

Select “Program” and click “Next”. 

  
3 

 

 You can enter the path to the OPC server via “Browse…”.  
The default path is  
“C:\Program Files\Analyze IT\AO-OPC\OptimaOPC.exe” or  
“C:\Program Files (x86)\Analyze IT\AO-OPC\OptimaOPC.exe” in the 64 bit version of 
Windows 7.  

Here you have to select the program file of the OPC client on the OPC client computer. 
Click “Next”. 
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4 

 

 Select “Allow the connection” and click “Next”. 

  
5 

 

 Select the profiles for which the rule should apply and click “Next”. 
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6 

 

 Finally, give the rule a name and provide it with a comment if required. Complete the 
creation of the rule with “Finish”. 

  
7 Repeat these steps for the “OPCEnum” service. The program file is normally installed 

under “C:\Windows\System32\OpcEnum.exe”.  

The file is normally located under “C:\Windows\SysWOW64\OpcEnum.exe” in the 
64 bit version of Windows 7. 
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8 Furthermore, you have to enable TCP port 135 for the DCOM communication. 

This setting must be made on the AO-OPC server computer and the OPC client com-
puter.  

The settings are made in the same way as for a program share, therefore only the dia-
logs which differ from the share dialogs for the OPC server are shown in the following. 

Select rule type “Port” under “New Rule…”. 

 

 
  

 

 

 Enter port “135” under “Specific local ports:”. 
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Completing the config-
uration and important 
information 

Re-start the computer. 

Any re-registration of the AO-OPC server causes the DCOM settings for the “Optima 
OPC Service” application to be reset. This could mean that the access of a remote OPC 
client first of all has to be enabled again. 

If the AO-OPC server is launched via the OPC client, it takes quite a while before the list 
of the tags is provided by the AO-OPC server. It is therefore possible that certain tags 
are not found after start-up. These tags are displayed after a while. 

  
Trouble-shooting:  
No connection to 
OPC client 

If the OPC server is automatically launched at the system start and a connection to a 
OPC client cannot be subsequently started (although all the DCOM and Firewall set-
tings were carried out in accordance with the above description), first of all try to re-
start the OPC server and the OPCEnum service via the “Control Panel → System and  
Security → Administrative Tools → Services”. If it starts, there may be a problem with 
the network configuration.  

If a fixed IP address is allocated to a network interface and no default gateway has 
been entered for this interface, it can prevent the OPC server from starting correctly.  
In this case, check the Windows Protocol “System” in the Event Viewer under “Control 
Panel → System and Security → Administrative Tools → Event Viewer” for warnings or 
errors with the source “Distributed COM” or “DNS Client Events”. 
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Special DCOM settings 
under Windows 10 Fall 
Creators Update  
(Version 1709) or newer 

If the remote access of an OPC-Client from a remote client is not possible under Win-
dows 10, a user or a user group must probably be entered in the DCOM access rights of 
the server PC. 

Open the Control Panel und select “Control Panel → All Control Panel Items → Adminis-
trative Tools → Computer Management”: 

 

On the left side, select “Computer Management → System → Local Users and Groups → 
Groups” and double-click in the right-hand window “Distributed COM Users”: 

 

In the “Members” field enter all users that should have access to DCOM. In the simplest 
case you enter here "Everyone", then all users should have access to the DCOM func-
tionality. 
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Data tags 

Preface 

  
Elements of tags Tags are composed fundamentally of several names separated by dots. Certain names 

are followed by an index in the form of a number in order that objects with more than 
one instance can be given a unique name. 

Example:  
“Optima1.Analyzer2.MainDetectorCount” designates the number of primary compo-
nents (MainDetectorCount) of the second analyzer (Analyzer2) of the first gas analyzer 
(Optima1). 

  
Indices In the following tag tables the indices are replaced with wildcards (*). The indices are 

counted from 1 up to the maximum number for each object. 

With the tag “Optima*.IO_Card” there is also the index IO_Card0 which addresses the 
gas analyzer’s I/Os located on the Syscon board. 

  
Legend Format VT_BOOL Bool 

VT_BSTR OLE automation string 

VT_I4 4-byte signed integer 

VT_R8 8-byte real number 

M/D M Tags required for displaying the measurement functions of the 
gas analyzer (basic information) 

D Tags required for displaying further functions of the gas analyzer 
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Connection status 

Tag Description Format M/D 

Optima*.IsConnected1 Connection status to the primary IP address VT_BOOL M 

Optima*.IsConnected2 Connection status to the secondary IP address VT_BOOL M 

General data 

Tag Description Format M/D 

Optima reference no. 

Optima*.AnalyzerCount Number of analyzers VT_I4 D 

Optima*.IO_CardCount Number of I/O cards VT_I4 D 

Optima*.IO_ModuleCount Number of bus I/Os VT_I4 D 

Optima*.Component_Count Number of components VT_I4 D 

Optima*.AI_Count Number of analog inputs VT_I4 D 

Optima*.AO_Count Number of analog outputs VT_I4 D 

Optima*.DI_Count Number of digital inputs VT_I4 D 

Optima*.DO_Count Number of digital outputs VT_I4 D 

Optima*.SystemAuxiliaryCount System auxiliary module count VT_I4 D 

Optima*.UrasCount Uras module count VT_I4 D 

Optima*.LimasCount Limas module count VT_I4 D 

Optima*.CaldosCount Caldos module count VT_I4 D 

Optima*.MagnosCount Magnos module count VT_I4 D 

Optima*.FIDCount FID module count VT_I4 D 

Optima*.ZO23Count ZO23 module count VT_I4 D 

Optima*.LS25Count LS25 module count VT_I4 D 

Optima*.ACF5000Count ACF5000 module count VT_I4 D 

Optima*.NoErrors Number of global device errors VT_I4 M 

Optima*.NoMaintMode Maintenance mode if ≠ 0 VT_I4 M 

Optima*.NoMaintReq Maintenance request if ≠ 0 VT_I4 M 

Optima*.SoftwareVersion Software version of the gas analyzer VT_BSTR D 

Optima*.SoftwareBuild Software build of the gas analyzer VT_BSTR D 

Optima*.ProductID Product ID of the device VT_BSTR D 

Optima*.SerialNo Serial number of the device VT_BSTR D 

Optima*.FabricationNo Fabrication number of the device VT_BSTR D 

Optima*.AnalyzerModuleNames Module names of configured modules VT_BSTR D 

Optima*.SystemMessages System messages of the device as an XML string  
(see section “XML description of system messages” 
on page 51). 

VT_BSTR M 
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Analyzer data 

Tag Description Format M/D 

Optima reference no., analyzer no. 

Optima*.Analyzer*.ModuleName Module name VT_BSTR M 

Optima*.Analyzer*.UserText User text VT_BSTR M 

Optima*.Analyzer*.SerialNo Serial number VT_BSTR D 

Optima*.Analyzer*.MainDetectorCount Number of main detectors VT_I4 D 

Optima*.Analyzer*.AuxDetectorCount Number of auxiliary detectors VT_I4 D 

Optima reference no., analyzer no., main detector no. 

Optima*.Analyzer*.MainDetector*. 
CompCount 

Number of components of main detector VT_I4 D 

Optima*.Analyzer*.MainDetector*. 
ActiveComponent 

Index of the active component of the main detector VT_I4 D 

Optima*.Analyzer*.MainDetector*. 
OffsetOver 

Threshold at which the offset drift exceeds the per-
missible range. 

VT_R8 D 

Optima*.Analyzer*.MainDetector*. 
AmplOver 

Threshold at which the amplification drift exceeds 
the permissible range. 

VT_R8 D 

Optima*.Analyzer*.MainDetector*. 
DeltaOffset 

Threshold at which the offset drift between two au-
tomatic calibrations exceeds the permissible range. 

VT_R8 D 

Optima*.Analyzer*.MainDetector*. 
DeltaAmpl 

Threshold at which the amplification drift between two 
automatic calibrations exceeds the permissible range. 

VT_R8 D 

Optima reference no., analyzer no., main detector no., component no. 

Optima*.Analyzer*.MainDetector*. 
Component*.CompName 

Component name VT_BSTR M 

Optima*.Analyzer*.MainDetector*. 
Component*.UnitName 

Unit name VT_BSTR M 

Optima*.Analyzer*.MainDetector*. 
Component*.MeasVal 

Measured value VT_R8 M 

Optima*.Analyzer*.MainDetector*. 
Component*.Status 

Status VT_I4 D 

Optima*.Analyzer*.MainDetector*. 
Component*.RangeLow 

Measuring range start VT_R8 D 

Optima*.Analyzer*.MainDetector*. 
Component*.RangeHigh 

Measuring range end VT_R8 D 

Optima*.Analyzer*.MainDetector*. 
Component*.MeasRangeCount 

Measuring range count VT_I4 D 

Optima reference no., analyzer no., main detector no., component no., measuring range no. 

Optima*.Analyzer*.MainDetector*. 
Component*.MeasIdx*.OffsetDrift 

Cumulative offset drift since the base calibration VT_R8 D 

Optima*.Analyzer*.MainDetector*. 
Component*.MeasIdx*.AmplDrift 

Cumulative amplification drift since the base cali-
bration 

VT_R8 D 

Optima*.Analyzer*.MainDetector*. 
Component*.MeasIdx*.DeltaOffsetDrift 

Offset drift between two automatic calibrations VT_R8 D 

Optima*.Analyzer*.MainDetector*. 
Component*.MeasIdx*.DeltaAmplDrift 

Amplification drift between two automatic calibra-
tions 

VT_R8 D 
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Tag Description Format M/D 

Optima reference no., analyzer no., auxiliary detector no. 

Optima*.Analyzer*.AuxDetector*. 
CompCount 

Number of components of auxiliary detector VT_I4 D 

Optima*.Analyzer*.AuxDetector*. 
ActiveComponent 

Index of the active component of the auxiliary detec-
tor 

VT_I4 D 

Optima reference no., analyzer no., auxiliary detector no., component no. 

Optima*.Analyzer*.AuxDetector*. 
Component*.CompName 

Component names VT_BSTR M 

Optima*.Analyzer*.AuxDetector*. 
Component*.UnitName 

Unit name VT_BSTR M 

Optima*.Analyzer*.AuxDetector*. 
Component*.MeasVal 

Measured value VT_R8 M 

Optima*.Analyzer*.AuxDetector*. 
Component*.Status 

Status VT_I4 D 

Optima*.Analyzer*.AuxDetector*. 
Component*.RangeLow 

Measuring range start VT_R8 D 

Optima*.Analyzer*.AuxDetector*. 
Component*.RangeHigh 

Measuring range end VT_R8 D 
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I/O data 

Tag Description Format M/D 

Optima reference no., I/O card no. 

Optima*.IO_Card*.DeviceName I/O device name VT_BSTR M 

Optima*.IO_Card*.UserText User text VT_BSTR M 

Optima*.IO_Card*.SerialNo Serial number VT_BSTR D 

Optima*.IO_Card*.SlotNo Slot number VT_I4 D 

Optima*.IO_Card*.AI_Count Number of analog inputs VT_I4 D 

Optima*.IO_Card*.AO_Count Number of analog outputs VT_I4 D 

Optima*.IO_Card*.DI_Count Number of digital inputs VT_I4 D 

Optima*.IO_Card*.DO_Count Number of digital outputs VT_I4 D 

Optima reference no., I/O card no., analog input no. 

Optima*.IO_Card*.AI*.Name Name VT_BSTR M 

Optima*.IO_Card*.AI*.Unit Unit VT_BSTR M 

Optima*.IO_Card*.AI*.Val Value VT_R8 M 

Optima*.IO_Card*.AI*.Status Status VT_I4 D 

Optima*.IO_Card*.AI*.HardwareLink Channel address of the component VT_I4 D 

Optima*.IO_Card*.AI*.RangeLow Measuring range start VT_R8 D 

Optima*.IO_Card*.AI*.RangeHigh Measuring range end VT_R8 D 

Optima reference no., I/O card no., analog output no. 

Optima*.IO_Card*.AO*.Name Name VT_BSTR M 

Optima*.IO_Card*.AO*.Unit Unit VT_BSTR M 

Optima*.IO_Card*.AO*.Val Value VT_R8 M 

Optima*.IO_Card*.AO*.Status Status VT_I4 D 

Optima*.IO_Card*.AO*.HardwareLink Channel address of the component VT_I4 D 

Optima*.IO_Card*.AO*.RangeLow Measuring range start VT_R8 D 

Optima*.IO_Card*.AO*.RangeHigh Measuring range end VT_R8 D 

Optima reference no., I/O card no., digital input no. 

Optima*.IO_Card*.DI*.Name Name VT_BSTR M 

Optima*.IO_Card*.DI*.Val Value VT_I4 M 

Optima*.IO_Card*.DI*.Invert Invert value of the function block VT_I4 D 

Optima*.IO_Card*.DI*.Status Status VT_I4 D 

Optima*.IO_Card*.DI*.HardwareLink Channel address of the component VT_I4 D 

Optima reference no., I/O card no., digital output no. 

Optima*.IO_Card*.DO*.Name Name VT_BSTR M 

Optima*.IO_Card*.DO*.Val Value VT_I4 M 

Optima*.IO_Card*.DO*.Invert Invert value of the function block VT_I4 D 

Optima*.IO_Card*.DO*.Status Status VT_I4 D 

Optima*.IO_Card*.DO*.HardwareLink Channel address of the component VT_I4 D 
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Bus I/O data 

Tag Description Format M/D 

Optima reference no., bus I/O no. 

Optima*.BusIO*.AI_Count Number of analog inputs VT_I4 D 

Optima*.BusIO*.AO_Count Number of analog outputs VT_I4 D 

Optima*.BusIO*.DI_Count Number of digital inputs VT_I4 D 

Optima*.BusIO*.DO_Count Number of digital outputs VT_I4 D 

Optima reference no., bus I/O no., analog input no. 

Optima*.BusIO*.AI*.Name Name VT_BSTR M 

Optima*.BusIO*.AI*.Val Value VT_R8 M 1) 

Optima*.BusIO*.AI*.Status Status VT_I4 D 

Optima*.BusIO*.AI*.RangeLow Measuring range start VT_R8 D 

Optima*.BusIO*.AI*.RangeHigh Measuring range end VT_R8 D 

Optima reference no., bus I/O no., analog output no. 

Optima*.BusIO*.AO*.Name Name VT_BSTR M 

Optima*.BusIO*.AO*.Val Value VT_R8 M 

Optima*.BusIO*.AO*.Status Status VT_I4 D 

Optima*.BusIO*.AO*.RangeLow Measuring range start VT_R8 D 

Optima*.BusIO*.AO*.RangeHigh Measuring range end VT_R8 D 

Optima reference no., bus I/O no., digital input no. 

Optima*.BusIO*.DI*.Name Name VT_BSTR M 

Optima*.BusIO*.DI*.Val Value VT_I4 M 1) 

Optima*.BusIO*.DI*.Invert Invert value of the function block VT_I4 D 

Optima*.BusIO*.DI*.Status Status VT_I4 D 

Optima reference no., bus I/O no., digital output no. 

Optima*.BusIO*.DO*.Name Name VT_BSTR M 

Optima*.BusIO*.DO*.Val Value VT_I4 M 

Optima*.BusIO*.DO*.Invert Invert value of the function block VT_I4 D 

Optima*.BusIO*.DO*.Status Status VT_I4 D 

 1) writable 
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System auxiliary data 

Tag Description Format M/D 

Optima reference no., System Auxiliary no. 

Optima*.SystemAuxiliary*.PressureCount Number of pressure modules VT_I4 D 

Optima*.SystemAuxiliary*.FlowCount Number of flow modules VT_I4 D 

Optima*.SystemAuxiliary*.SCCCCount Number of SCC-C modules VT_I4 D 

Optima*.SystemAuxiliary*.SCCFCount Number of SCC-F modules VT_I4 D 

Optima*.SystemAuxiliary*.PneumaticCount Number of pneumatic modules VT_I4 D 

Optima reference no., System auxiliary no., pressure no. 

Optima*.SystemAuxiliary*.Pressure*.MeasVal Measuring value pressure VT_R8 M 

Optima*.SystemAuxiliary*.Pressure*.RangeLow Range low pressure VT_R8 D 

Optima*.SystemAuxiliary*.Pressure*.RangeHigh Range high pressure VT_R8 D 

Optima reference no. System auxiliary no., flow no. 

Optima*.SystemAuxiliary*.Flow*.MeasVal Measuring value Flow VT_R8 M 

Optima*.SystemAuxiliary*.Flow*.RangeLow Range low Flow VT_R8 D 

Optima*.SystemAuxiliary*.Flow*.RangeHigh Range high Flow VT_R8 D 

Optima reference no., System auxiliary no., SCC-C no. 

Optima*.SystemAuxiliary*.SCCC*.MeasVal Measuring value SCC-C temperature VT_R8 M 

Optima*.SystemAuxiliary*.SCCC*.RangeLow Range low SCC-C temperature VT_R8 D 

Optima*.SystemAuxiliary*.SCCC*.RangeHigh Range high SCC-C temperature VT_R8 D 

Optima reference no., System auxiliary no., SCC-F no. 

Optima*.SystemAuxiliary*.SCCF*.PumpCount Number of diaphragm pumps VT_I4 D 

Optima reference no., System auxiliary no., SCC-F no., pump no. 

Optima*.SystemAuxiliary*.SCCF*.Pump*.OnOff Status (on/off) of the pump VT_I4 M 

Optima reference no., System auxiliary no., pneumatic no. 

Optima*.SystamAuxiliary*.Pneumatic*.PumpCount Number of pumps VT_I4 D 

Optima reference no., System auxiliary no., pneumatic no., pump no. 

Optima*.SystemAuxiliary*.Pneumatic*.Pump*.OnOff Status (on/off) of the pump VT_I4 M 

Optima*.SystemAuxiliary*.Pneumatic*.Pump*.Power Pump power in percent VT_R8 M 
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Uras data 

Tag Description Format M/D 

Optima reference no., Uras no. 

Optima*.Uras*.ModuleName Module name VT_BSTR M 

Optima*.Uras*.UserText User text VT_BSTR M 

Optima*.Uras*.SerialNo Serial number VT_BSTR D 

Optima*.Uras*.FabricationNo Fabrication number VT_BSTR D 

Optima*.Uras*.SoftwareVersion Software version VT_BSTR D 

Optima*.Uras*.Status Status VT_I4 D 

Optima*.Uras*.DetectorCount Detector count VT_I4 D 

Optima*.Uras*.ReceiverTemperatureCount Receiver temperature count VT_I4 D 

Optima*.Uras*.CoverHeatingActual Measuring value of cover heating VT_R8 M 

Optima*.Uras*.CoverHeatingControlVariable Control variable of cover heating VT_R8 M 

Optima*.Uras*.CoverHeatingSetpoint Setpoint of cover heating VT_R8 D 

Optima reference no., Uras no., detector no. 

Optima*.Uras*.Detector*.IsUrasDetector TRUE if detector is an Uras detector VT_BOOL D 

Optima*.Uras*.Detector*.IsO2Detector TRUE if detector is an O2 Detector VT_BOOL D 

Optima*.Uras*.Detector*.Name Detector name VT_BSTR D 

Optima*.Uras*.Detector*.ComponentCount Component count VT_I4 D 

Optima*.Uras*.Detector*.ActiveComponent Active Component VT_I4 D 

Optima*.Uras*.Detector*.RawValue Raw value VT_R8 M 

Optima*.Uras*.Detector*.RawValueReal1F Raw value real value 1F VT_R8 M 

Optima*.Uras*.Detector*.RawValueIma1F Raw value imaginary value 1F VT_R8 M 

Optima*.Uras*.Detector*.RawValueReal2F Raw value real value 2F VT_R8 M 

Optima*.Uras*.Detector*.RawValueIma2F Raw value imaginary value 2F VT_R8 M 

Optima*.Uras*.Detector*.RawValuePeriod1 Raw value period 1 VT_R8 M 

Optima*.Uras*.Detector*.RawValuePeriod2 Raw value period 2 VT_R8 M 

Optima*.Uras*.Detector*.RawValueMotorStatistics Raw value motor statistics VT_R8 M 

Optima*.Uras*.Detector*.RawValue1FPhase Raw value 1F phase VT_R8 M 

Optima reference no., Uras no., detector no., component no. 

Optima*.Uras*.Detector*.Component*.Name Component name VT_BSTR M 

Optima*.Uras*.Detector*.Component*.Unit Component unit VT_BSTR M 

Optima*.Uras*.Detector*.Component*.MeasVal Measuring value VT_R8 M 

Optima*.Uras*.Detector*.Component*.Status Status VT_I4 D 

Optima*.Uras*.Detector*.Component*.RangeLow Measuring range start VT_R8 D 

Optima*.Uras*.Detector*.Component*.RangeHigh Measuring range end VT_R8 D 

Optima*.Uras*.Detector*.Component*. 
MeasRangeCount 

Measuring range count VT_I4 D 

Optima*.Uras*.Detector*.Component*. 
ActiveMeasRange 

Active measuring range VT_I4 D 

Optima*.Uras*.Detector*.Component*. 
CalibrationCellConcentration 

Calibration cell concentration component VT_R8 D 

Optima*.Uras*.Detector*.Component*. 
CalibrationCellFactor 

Calibration cell factor VT_R8 D 
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Tag Description Format M/D 

Optima*.Uras*.Detector*.Component*. 
LowPassNonLinearTimeConstant 

Low-pass non-linear filter, low-pass time 
constant 

VT_R8 D 

Optima*.Uras*.Detector*.Component*. 
LowPassNonLinearFilterTimeConstant 

Low-pass non-linear filter, non-linear filter 
low-pass time constant 

VT_R8 D 

Optima*.Uras*.Detector*.Component*. 
LowPassNonLinearFilterThreshold 

Low-pass non-linear filter, non-linear filter 
threshold 

VT_R8 D 

Optima reference no., Uras no., detector no., component no., measuring range no. 

Optima*.Uras*.Detector*.Component*.MeasRange*. 
OffsetDriftActual 

Cumulative offset drift since the base cal-
ibration, actual value 

VT_R8 D 

Optima*.Uras*.Detector*.Component*.MeasRange*. 
OffsetDriftLimit 

Cumulative offset drift since the base cal-
ibration, limit value 

VT_R8 D 

Optima*.Uras*.Detector*.Component*.MeasRange*. 
AmplDriftActual 

Cumulative amplification drift since the 
base calibration, actual value 

VT_R8 D 

Optima*.Uras*.Detector*.Component*.MeasRange*. 
AmplDriftLimit 

Cumulative amplification drift since the 
base calibration, limit value 

VT_R8 D 

Optima*.Uras*.Detector*.Component*.MeasRange*. 
DeltaOffsetDriftActual 

Offset drift between two automatic cali-
brations, actual value 

VT_R8 D 

Optima*.Uras*.Detector*.Component*.MeasRange*. 
DeltaOffsetDriftLimit 

Offset drift between two automatic cali-
brations, limit value 

VT_R8 D 

Optima*.Uras*.Detector*.Component*.MeasRange*. 
DeltaAmplDriftActual 

Amplification drift between two auto-
matic calibrations, actual value 

VT_R8 D 

Optima*.Uras*.Detector*.Component*.MeasRange*. 
DeltaAmplDriftLimit 

Amplification drift between two auto-
matic calibrations, limit value 

VT_R8 D 

Optima reference no., Uras no., receiver temp. no. 

Optima*.Uras*.ReceiverTemperature*.MeasVal Measuring value receiver temperature VT_R8 M 
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Limas data 

Tag Description Format M/D 
Optima reference no., Limas no. 
Optima*.Limas*.ModuleName Module name VT_BSTR M 
Optima*.Limas*.UserText User text VT_BSTR M 
Optima*.Limas*.SerialNo Serial number VT_BSTR D 
Optima*.Limas*.FabricationNo Fabrication number VT_BSTR D 
Optima*.Limas*.SoftwareVersion Software version VT_BSTR D 
Optima*.Limas*.Status Status VT_I4 D 
Optima*.Limas*.DetectorCount Detector count VT_I4 D 
Optima*.Limas*.SampleCellHeatingActual Measuring value of sample cell heating VT_R8 M 
Optima*.Limas*.SampleCellHeatingControlVariable Control variable of sample cell heating VT_R8 M 
Optima*.Limas*.SampleCellHeatingSetpoint Setpoint of sample cell heating VT_R8 D 
Optima*.Limas*.BeamSplitterHeatingActual Measuring value of beam splitter heating VT_R8 M 
Optima*.Limas*.BeamSplitterHeatingControlVariable Control variable of beam splitter heating VT_R8 M 
Optima*.Limas*.BeamSplitterHeatingSetpoint Setpoint of beam splitter heating VT_R8 D 
Optima*.Limas*.EDLHeatingActual Measuring value of EDL heating VT_R8 M 
Optima*.Limas*.EDLHeatingControlVariable Control variable of EDL heating VT_R8 M 
Optima*.Limas*.EDLHeatingSetpoint Setpoint of EDL heating VT_R8 D 
Optima*.Limas*.MeasDetectorTemperatureActual Measuring value of measuring detector VT_R8 M 
Optima*.Limas*.MeasDetectorTemperatureSetpoint Setpoint of measuring detector VT_R8 D 
Optima*.Limas*.RefDetectorTemperatureActual Measuring value of reference detector VT_R8 M 
Optima*.Limas*.RefDetectorTemperatureSetpoint Setpoint of reference detector VT_R8 D 
Optima*.Limas*.BoardTemperature Measuring value of board temperature VT_R8 M 

Optima reference no., Limas no., detector no. 
Optima*.Limas*.Detector*.IsLimasDetector TRUE if detector is a Limas detector VT_BOOL D 
Optima*.Limas*.Detector*.IsVirtualDetector TRUE if detector is a virtual Detector VT_BOOL D 
Optima*.Limas*.Detector*.Name Detector name VT_BSTR D 
Optima*.Limas*.Detector*.ComponentCount Component count VT_I4 D 
Optima*.Limas*.Detector*.ActiveComponent Active Component VT_I4 D 
Optima*.Limas*.Detector*.MeasDetMeasPhaseActual Actual intensity measurement detector 

measurement phase 
VT_R8 M 

Optima*.Limas*.Detector*.MeasDetMeasPhaseInit Initial intensity measurement detector 
measurement phase 

VT_R8 D 

Optima*.Limas*.Detector*.MeasDetRefPhaseActual Actual intensity measurement detector 
reference phase 

VT_R8 M 

Optima*.Limas*.Detector*.MeasDetRefPhaseInit Initial intensity measurement detector 
reference phase 

VT_R8 D 

Optima*.Limas*.Detector*.RefDetMeasPhaseActual Actual intensity reference detector meas-
urement phase 

VT_R8 M 

Optima*.Limas*.Detector*.RefDetMeasPhaseInit Initial intensity reference detector meas-
urement phase 

VT_R8 D 

Optima*.Limas*.Detector*.RefDetRefPhaseActual Actual intensity reference detector refer-
ence phase 

VT_R8 M 

Optima*.Limas*.Detector*.RefDetRefPhaseInit Initial intensity reference detector refer-
ence phase 

VT_R8 D 

Optima*.Limas*.Detector*.RawValue Raw value VT_R8 M 
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Tag Description Format M/D 
Optima reference no., Limas no., detector no., component no. 

Optima*.Limas*.Detector*.Component*.Name Component name VT_BSTR M 

Optima*.Limas*.Detector*.Component*.Unit Component unit VT_BSTR M 

Optima*.Limas*.Detector*.Component*.MeasVal Measuring value VT_R8 M 

Optima*.Limas*.Detector*.Component*.Status Status VT_I4 D 

Optima*.Limas*.Detector*.Component*.RangeLow Measuring range start VT_R8 D 

Optima*.Limas*.Detector*.Component*.RangeHigh Measuring range end VT_R8 D 

Optima*.Limas*.Detector*.Component*. 
MeasRangeCount 

Measuring range count VT_I4 D 

Optima*.Limas*.Detector*.Component*. 
ActiveMeasRange 

Active measuring range number VT_I4 D 

Optima*.Limas*.Detector*.Component*. 
CalibrationCellConcentration 

Calibration cell concentration component VT_R8 D 

Optima*.Limas*.Detector*.Component*. 
CalibrationCellFactor 

Calibration cell factor VT_R8 D 

Optima*.Limas*.Detector*.Component*. 
LowPassNonLinearTimeConstant 

Low-pass non-linear filter, low-pass time 
constant 

VT_R8 D 

Optima*.Limas*.Detector*.Component*. 
LowPassNonLinearFilterTimeConstant 

Low-pass non-linear filter, non-linear filter 
low-pass time constant 

VT_R8 D 

Optima*.Limas*.Detector*.Component*. 
LowPassNonLinearFilterThreshold 

Low-pass non-linear filter, non-linear filter 
threshold 

VT_R8 D 

Optima reference no., Limas no., detector no., component no., measuring range no. 

Optima*.Limas*.Detector*.Component*.MeasRange*. 
OffsetDriftActual 

Cumulative offset drift since the base  
calibration, actual value 

VT_R8 D 

Optima*.Limas*.Detector*.Component*.MeasRange*. 
OffsetDriftLimit 

Cumulative offset drift since the base  
calibration, limit value 

VT_R8 D 

Optima*.Limas*.Detector*.Component*.MeasRange*. 
AmplDriftActual 

Cumulative amplification drift since the 
base calibration, actual value 

VT_R8 D 

Optima*.Limas*.Detector*.Component*.MeasRange*. 
AmplDriftLimit 

Cumulative amplification drift since the 
base calibration, limit value 

VT_R8 D 

Optima*.Limas*.Detector*.Component*.MeasRange*. 
DeltaOffsetDriftActual 

Offset drift between two automatic cali-
brations, actual value 

VT_R8 D 

Optima*.Limas*.Detector*.Component*.MeasRange*. 
DeltaOffsetDriftLimit 

Offset drift between two automatic cali-
brations, limit value 

VT_R8 D 

Optima*.Limas*.Detector*.Component*.MeasRange*. 
DeltaAmplDriftActual 

Amplification drift between two auto-
matic calibrations, actual value 

VT_R8 D 

Optima*.Limas*.Detector*.Component*.MeasRange*. 
DeltaAmplDriftLimit 

Amplification drift between two auto-
matic calibrations, limit value 

VT_R8 D 
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Caldos data 

Tag Description Format M/D 

Optima reference no., Caldos no. 

Optima*.Caldos*.ModuleName Module name VT_BSTR M 

Optima*.Caldos*.UserText User text VT_BSTR M 

Optima*.Caldos*.SerialNo Serial number VT_BSTR D 

Optima*.Caldos*.FabricationNo Fabrication number VT_BSTR D 

Optima*.Caldos*.SoftwareVersion Software version VT_BSTR D 

Optima*.Caldos*.Status Status VT_I4 D 

Optima*.Caldos*.DetectorCount Detector count VT_I4 D 

Optima*.Caldos*.DetectorHeatingActual Measuring value of detector heating VT_R8 M 

Optima*.Caldos*.DetectorHeatingControlVariable Control variable of detector heating VT_R8 M 

Optima*.Caldos*.DetectorHeatingSetpoint Setpoint of detector heating VT_R8 D 

Optima reference no., Caldos no., detector no. 

Optima*.Caldos*.Detector*.Name Detector name VT_BSTR D 

Optima*.Caldos*.Detector*.ComponentCount Component count VT_I4 D 

Optima*.Caldos*.Detector*.ActiveComponent Active Component VT_I4 D 

Optima*.Caldos*.Detector*.RawValue Raw value VT_R8 M 

Optima reference no., Caldos no., detector no., component no. 

Optima*.Caldos*.Detector*.Component*.Name Component name VT_BSTR M 

Optima*.Caldos*.Detector*.Component*.Unit Component unit VT_BSTR M 

Optima*.Caldos*.Detector*.Component*.MeasVal Measuring value VT_R8 M 

Optima*.Caldos*.Detector*.Component*.Status Status VT_I4 D 

Optima*.Caldos*.Detector*.Component*.RangeLow Measuring range start VT_R8 D 

Optima*.Caldos*.Detector*.Component*.RangeHigh Measuring range end VT_R8 D 

Optima*.Caldos*.Detector*.Component*. 
MeasRangeCount 

Measuring range count VT_I4 D 

Optima*.Caldos*.Detector*.Component*. 
ActiveMeasRange 

Active measuring range VT_I4 D 

Optima*.Caldos*.Detector*.Component*. 
LowPassNonLinearTimeConstant 

Low-pass non-linear filter, low-pass time 
constant 

VT_R8 D 

Optima*.Caldos*.Detector*.Component*. 
LowPassNonLinearFilterTimeConstant 

Low-pass non-linear filter, non-linear 
filter low-pass time constant 

VT_R8 D 

Optima*.Caldos*.Detector*.Component*. 
LowPassNonLinearFilterThreshold 

Low-pass non-linear filter, non-linear 
filter threshold 

VT_R8 D 

Optima reference no., Caldos no., detector no., component no., measuring range no. 

Optima*.Caldos*.Detector*.Component*.MeasRange*. 
OffsetDriftActual 

Cumulative offset drift since the base 
calibration, actual value 

VT_R8 D 

Optima*.Caldos*.Detector*.Component*.MeasRange*. 
OffsetDriftLimit 

Cumulative offset drift since the base 
calibration, limit value 

VT_R8 D 

Optima*.Caldos*.Detector*.Component*.MeasRange*. 
AmplDriftActual 

Cumulative amplification drift since the 
base calibration, actual value 

VT_R8 D 

Optima*.Caldos*.Detector*.Component*.MeasRange*. 
AmplDriftLimit 

Cumulative amplification drift since the 
base calibration, limit value 

VT_R8 D 
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Tag Description Format M/D 

Optima*.Caldos*.Detector*.Component*.MeasRange*. 
DeltaOffsetDriftActual 

Offset drift between two automatic cali-
brations, actual value 

VT_R8 D 

Optima*.Caldos*.Detector*.Component*.MeasRange*. 
DeltaOffsetDriftLimit 

Offset drift between two automatic cali-
brations, limit value 

VT_R8 D 

Optima*.Caldos*.Detector*.Component*.MeasRange*. 
DeltaAmplDriftActual 

Amplification drift between two auto-
matic calibrations, actual value 

VT_R8 D 

Optima*.Caldos*.Detector*.Component*.MeasRange*. 
DeltaAmplDriftLimit 

Amplification drift between two auto-
matic calibrations, limit value 

VT_R8 D 
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Magnos data 

Tag Description Format M/D 

Optima reference no., Magnos no. 

Optima*.Magnos*.ModuleName Module name VT_BSTR M 

Optima*.Magnos*.UserText User text VT_BSTR M 

Optima*.Magnos*.SerialNo Serial number VT_BSTR D 

Optima*.Magnos*.FabricationNo Fabrication number VT_BSTR D 

Optima*.Magnos*.SoftwareVersion Software version VT_BSTR D 

Optima*.Magnos*.Status Status VT_I4 D 

Optima*.Magnos*.DetectorCount Detector count VT_I4 D 

Optima*.Magnos*.ChamberHeatingActual Measuring value of chamber heating VT_R8 M 

Optima*.Magnos*.ChamberHeatingControlVariable Control variable of chamber heating VT_R8 M 

Optima*.Magnos*.ChamberHeatingSetpoint Setpoint of chamber heating VT_R8 D 

Optima*.Magnos*.ADCHeatingActual Measuring value of ADC heating VT_R8 M 

Optima*.Magnos*.ADCHeatingControlVariable Control variable of ADC heating VT_R8 M 

Optima*.Magnos*.ADCHeatingSetpoint Setpoint of ADC heating VT_R8 D 

Optima*.Magnos*.PreamplifiedBoardTempActual Measuring value of preampl. board temp. VT_R8 M 

Optima*.Magnos*.BoardTemperature Measuring value of board temperature VT_R8 M 

Optima reference no., Magnos no., detector no. 

Optima*.Magnos*.Detector*.Name Detector name VT_BSTR D 

Optima*.Magnos*.Detector*.ComponentCount Component count VT_I4 D 

Optima*.Magnos*.Detector*.ActiveComponent Active component VT_I4 D 

Optima*.Magnos*.Detector*.RawValue Raw value VT_R8 M 

Optima*.Magnos*.Detector*.RawValueADC Raw value ADC VT_R8 M 

Optima*.Magnos*.Detector*.RawValueADCPhotoDiode1 Raw value ADC photo diode 1 VT_R8 M 

Optima*.Magnos*.Detector*.RawValueADCPhotoDiode2 Raw value ADC photo diode 2 VT_R8 M 

Optima*.Magnos*.Detector*.RawValueADCDumbBell Raw value ADC dumb bell VT_R8 M 

Optima*.Magnos*.Detector*.RawValueADCTemperature Raw value ADC temperature VT_R8 M 

Optima*.Magnos*.Detector*. 
RawValueADCDigitalSupplyVoltage 

Raw value ADC digital supply voltage VT_R8 M 

Optima*.Magnos*.Detector*. 
RawValueADCAnalogSupplyVoltage 

Raw value ADC analog supply voltage VT_R8 M 

Optima reference no., Magnos no., detector no., component no. 

Optima*.Magnos*.Detector*.Component*.Name Component name VT_BSTR M 

Optima*.Magnos*.Detector*.Component*.Unit Component unit VT_BSTR M 

Optima*.Magnos*.Detector*.Component*.MeasVal Measuring value VT_R8 M 

Optima*.Magnos*.Detector*.Component*.Status Status VT_I4 D 

Optima*.Magnos*.Detector*.Component*.RangeLow Measuring range start VT_R8 D 

Optima*.Magnos*.Detector*.Component*.RangeHigh Measuring range end VT_R8 D 

Optima*.Magnos*.Detector*.Component*. 
MeasRangeCount 

Measuring range count VT_I4 D 

Optima*.Magnos*.Detector*.Component*. 
ActiveMeasRange 

Active measuring range VT_I4 D 
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Tag Description Format M/D 

Optima*.Magnos*.Detector*.Component*. 
LowPassNonLinearTimeConstant 

Low-pass non-linear filter, low-pass time 
constant 

VT_R8 D 

Optima*.Magnos*.Detector*.Component*. 
LowPassNonLinearFilterTimeConstant 

Low-pass non-linear filter, non-linear 
filter low-pass time constant 

VT_R8 D 

Optima*.Magnos*.Detector*.Component*. 
LowPassNonLinearFilterThreshold 

Low-pass non-linear filter, non-linear 
filter threshold 

VT_R8 D 

Optima reference no., Magnos no., detector no., component no., measuring range no. 

Optima*.Magnos*.Detector*.Component*.MeasRange*. 
OffsetDriftActual 

Cumulative offset drift since the base 
calibration, actual value 

VT_R8 D 

Optima*.Magnos*.Detector*.Component*.MeasRange*. 
OffsetDriftLimit 

Cumulative offset drift since the base 
calibration, limit value 

VT_R8 D 

Optima*.Magnos*.Detector*.Component*.MeasRange*. 
AmplDriftActual 

Cumulative amplification drift since the 
base calibration, actual value 

VT_R8 D 

Optima*.Magnos*.Detector*.Component*.MeasRange*. 
AmplDriftLimit 

Cumulative amplification drift since the 
base calibration, limit value 

VT_R8 D 

Optima*.Magnos*.Detector*.Component*.MeasRange*. 
DeltaOffsetDriftActual 

Offset drift between two automatic cali-
brations, actual value 

VT_R8 D 

Optima*.Magnos*.Detector*.Component*.MeasRange*. 
DeltaOffsetDriftLimit 

Offset drift between two automatic cali-
brations, limit value 

VT_R8 D 

Optima*.Magnos*.Detector*.Component*.MeasRange*. 
DeltaAmplDriftActual 

Amplification drift between two auto-
matic calibrations, actual value 

VT_R8 D 

Optima*.Magnos*.Detector*.Component*.MeasRange*. 
DeltaAmplDriftLimit 

Amplification drift between two auto-
matic calibrations, limit value 

VT_R8 D 
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FID data 

Tag Description Format M/D 
Optima reference no., FID no. 
Optima*.FID*.ModuleName Module name VT_BSTR M 
Optima*.FID*.UserText User text VT_BSTR M 
Optima*.FID*.SerialNo Serial number VT_BSTR D 
Optima*.FID*.FabricationNo Fabrication number VT_BSTR D 
Optima*.FID*.SoftwareVersion Software version VT_BSTR D 
Optima*.FID*.Status Status VT_I4 D 
Optima*.FID*.DetectorCount Detector count VT_I4 D 
Optima*.FID*.SampleGasInletHeatingActual Measuring value of sample gas inlet heat. VT_R8 M 
Optima*.FID*.SampleGasInletHeatingControlVariable Control variable of sample gas inlet heat. VT_R8 M 
Optima*.FID*.SampleGasInletHeatingSetpoint Setpoint of sample gas inlet heating VT_R8 D 
Optima*.FID*.DetectorHeatingActual Measuring value of detector heating VT_R8 M 
Optima*.FID*.DetectorHeatingControlVariable Control variable of detector heating VT_R8 M 
Optima*.FID*.DetectorHeatingSetpoint Setpoint of detector heating VT_R8 D 
Optima*.FID*.NMHCHeatingActual Measuring value of NMHC heating VT_R8 M 
Optima*.FID*.NMHCHeatingControlVariable Control variable of NMHC heating VT_R8 M 
Optima*.FID*.NMHCHeatingSetpoint Setpoint of NMHC heating VT_R8 D 
Optima*.FID*.PreampHeatingActual Measuring value of preamplifier heating VT_R8 M 
Optima*.FID*.PreampHeatingControlVariable Control variable value of preamplifier 

heating 
VT_R8 M 

Optima*.FID*.PreampHeatingSetpoint Setpoint value of preamplifier heating VT_R8 D 
Optima*.FID*.FlameTemp1Actual Measuring value of flame temperature 1 VT_R8 M 
Optima*.FID*.FlameTemp1RangeLow Measuring range start of flame tempera-

ture 1 
VT_R8 D 

Optima*.FID*.FlameTemp1RangeHigh Measuring range end of flame tempera-
ture 1 

VT_R8 D 

Optima*.FID*.FlameTemp2Actual Measuring value of flame temperature 2 VT_R8 M 
Optima*.FID*.FlameTemp2RangeLow Measuring range start of flame tempera-

ture 2 
VT_R8 D 

Optima*.FID*.FlameTemp2RangeHigh Measuring range end of flame tempera-
ture 2 

VT_R8 D 

Optima*.FID*.CombustionAirPressActual Measuring value of combustion air pres-
sure 

VT_R8 M 

Optima*.FID*.CombustionAirPressControlVariable Control variable of combustion air pres-
sure 

VT_R8 M 

Optima*.FID*.CombustionAirPressSetpoint Setpoint of combustion air pressure VT_R8 D 
Optima*.FID*.CombustionGasPressActual Measuring value of combustion gas pres-

sure 
VT_R8 M 

Optima*.FID*.CombustionGasPressControlVariable Control variable of combustion gas pres-
sure 

VT_R8 M 

Optima*.FID*.CombustionGasPressSetpoint Setpoint of combustion gas pressure VT_R8 D 
Optima*.FID*.SampleGasInletPressActual Measuring value of sample gas inlet pres-

sure 
VT_R8 M 

Optima*.FID*.SampleGasInletPressControlVariable Control variable of sample gas inlet pres-
sure 

VT_R8 M 

Optima*.FID*.SampleGasInletPressSetpoint Setpoint of sample gas inlet pressure VT_R8 D 
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Tag Description Format M/D 
Optima*.FID*.SampleGasOuttletPressActual Measuring value of sample gas outlet 

pressure 
VT_R8 M 

Optima*.FID*.SampleGasOutletPressControlVariable Control variable of sample gas outlet 
pressure 

VT_R8 M 

Optima*.FID*.SampleGasOutletPressSetpoint Setpoint of sample gas outlet pressure VT_R8 D 
Optima*.FID*.FlowActual Measuring value VT_R8 M 
Optima*.FID*.FlowRangeLow Measuring range start VT_R8 D 
Optima*.FID*.FlowRangeHigh Measuring range end VT_R8 D 

Optima reference no., FID no., detector no. 
Optima*.FID*.Detector*.Name Detector name VT_BSTR D 
Optima*.FID*.Detector*.ComponentCount Component count VT_I4 D 
Optima*.FID*.Detector*.ActiveComponent Active Component VT_I4 D 
Optima*.FID*.Detector*.RawValue Raw value VT_R8 M 

Optima reference no., FID no., detector no., component no. 
Optima*.FID*.Detector*.Component*.Name Component name VT_BSTR M 
Optima*.FID*.Detector*.Component*.Unit Component unit VT_BSTR M 
Optima*.FID*.Detector*.Component*.MeasVal Measuring value VT_R8 M 
Optima*.FID*.Detector*.Component*.Status Status VT_I4 D 
Optima*.FID*.Detector*.Component*.RangeLow Measuring range start VT_R8 D 
Optima*.FID*.Detector*.Component*.RangeHigh Measuring range end VT_R8 D 
Optima*.FID*.Detector*.Component*. 
MeasRangeCount 

Measuring range count VT_I4 D 

Optima*.FID*.Detector*.Component*. 
ActiveMeasRange 

Active measuring range VT_I4 D 

Optima*.FID*.Detector*.Component*. 
LowPassNonLinearTimeConstant 

Low-pass non-linear filter, low-pass time 
constant 

VT_R8 D 

Optima*.FID*.Detector*.Component*. 
LowPassNonLinearFilterTimeConstant 

Low-pass non-linear filter, non-linear filter 
low-pass time constant 

VT_R8 D 

Optima*.FID*.Detector*.Component*. 
LowPassNonLinearFilterThreshold 

Low-pass non-linear filter, non-linear filter 
threshold 

VT_R8 D 

Optima reference no., FID no., detector no., component no., measuring range no. 
Optima*.FID*.Detector*.Component*.MeasRange*. 
OffsetDriftActual 

Cumulative offset drift since the base cal-
ibration, actual value 

VT_R8 D 

Optima*.FID*.Detector*.Component*.MeasRange*. 
OffsetDriftLimit 

Cumulative offset drift since the base cal-
ibration, limit value 

VT_R8 D 

Optima*.FID*.Detector*.Component*.MeasRange*. 
AmplDriftActual 

Cumulative amplification drift since the 
base calibration, actual value 

VT_R8 D 

Optima*.FID*.Detector*.Component*.MeasRange*. 
AmplDriftLimit 

Cumulative amplification drift since the 
base calibration, limit value 

VT_R8 D 

Optima*.FID*.Detector*.Component*.MeasRange*. 
DeltaOffsetDriftActual 

Offset drift between two automatic cali-
brations, actual value 

VT_R8 D 

Optima*.FID*.Detector*.Component*.MeasRange*. 
DeltaOffsetDriftLimit 

Offset drift between two automatic cali-
brations, limit value 

VT_R8 D 

Optima*.FID*.Detector*.Component*.MeasRange*. 
DeltaAmplDriftActual 

Amplification drift between two auto-
matic calibrations, actual value 

VT_R8 D 

Optima*.FID*.Detector*.Component*.MeasRange*. 
DeltaAmplDriftLimit 

Amplification drift between two auto-
matic calibrations, limit value 

VT_R8 D 
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ZO23 data 

Tag Description Format M/D 

Optima reference no., ZO23 no. 

Optima*.ZO23*.ModuleName Module name VT_BSTR M 

Optima*.ZO23*.UserText User text VT_BSTR M 

Optima*.ZO23*.SerialNo Serial number VT_BSTR D 

Optima*.ZO23*.FabricationNo Fabrication number VT_BSTR D 

Optima*.ZO23*.SoftwareVersion Software version VT_BSTR D 

Optima*.ZO23*.Status Status VT_I4 D 

Optima*.ZO23*.DetectorCount Detector count VT_I4 D 

Optima*.ZO23*.DetectorHeatingActual Measuring value of detector heating VT_R8 M 

Optima*.ZO23*.DetectorHeatingControlVariable Control variable of detector heating VT_R8 M 

Optima*.ZO23*.DetectorHeatingSetpoint Setpoint of detector heating VT_R8 D 

Optima*.ZO23*.FlowActual Measuring value of flow detector VT_R8 M 

Optima*.ZO23*.FlowControlVariable Control variable of flow detector VT_R8 M 

Optima*.ZO23*.FlowRangeLow Measuring range start of flow detect. VT_R8 D 

Optima*.ZO23*.FlowRangeHigh Measuring range end of flow detector VT_R8 D 

Optima reference no., ZO23 no., detector no. 

Optima*.ZO23*.Detector*.Name Detector name VT_BSTR D 

Optima*.ZO23*.Detector*.ComponentCount Component count VT_I4 D 

Optima*.ZO23*.Detector*.ActiveComponent Active component VT_I4 D 

Optima*.ZO23*.Detector*.RawValue Raw value VT_R8 M 

Optima reference no., ZO23 no., detector no., component no. 

Optima*.ZO23*.Detector*.Component*.Name Component name VT_BSTR M 

Optima*.ZO23*.Detector*.Component*.Unit Component unit VT_BSTR M 

Optima*.ZO23*.Detector*.Component*.MeasVal Measuring value VT_R8 M 

Optima*.ZO23*.Detector*.Component*.Status Status VT_I4 D 

Optima*.ZO23*.Detector*.Component*.RangeLow Measuring range start VT_R8 D 

Optima*.ZO23*.Detector*.Component*.RangeHigh Measuring range end VT_R8 D 

Optima*.ZO23*.Detector*.Component*.MeasRangeCount Measuring range count VT_I4 D 

Optima*.ZO23*.Detector*.Component*.ActiveMeasRange Active measuring range VT_I4 D 

Optima*.ZO23*.Detector*.Component*. 
LowPassNonLinearTimeConstant 

Low-pass non-linear filter, low-pass 
time constant 

VT_R8 D 

Optima*.ZO23*.Detector*.Component*. 
LowPassNonLinearFilterTimeConstant 

Low-pass non-linear filter, non-linear 
filter low-pass time constant 

VT_R8 D 

Optima*.ZO23*.Detector*.Component*. 
LowPassNonLinearFilterThreshold 

Low-pass non-linear filter, non-linear 
filter threshold 

VT_R8 D 

Optima reference no., ZO23 no., detector no., component no., measuring range no. 

Optima*.ZO23*.Detector*.Component*.MeasRange*. 
OffsetDriftActual 

Cumulative offset drift since the base 
calibration, actual value 

VT_R8 D 

Optima*.ZO23*.Detector*.Component*.MeasRange*. 
OffsetDriftLimit 

Cumulative offset drift since the base 
calibration, limit value 

VT_R8 D 

Optima*.ZO23*.Detector*.Component*.MeasRange*. 
AmplDriftActual 

Cumulative amplification drift since 
the base calibration, actual value 

VT_R8 D 
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Tag Description Format M/D 

Optima*.ZO23*.Detector*.Component*.MeasRange*. 
AmplDriftLimit 

Cumulative amplification drift since 
the base calibration, limit value 

VT_R8 D 

Optima*.ZO23*.Detector*.Component*.MeasRange*. 
DeltaOffsetDriftActual 

Offset drift between two automatic 
calibrations, actual value 

VT_R8 D 

Optima*.ZO23*.Detector*.Component*.MeasRange*. 
DeltaOffsetDriftLimit 

Offset drift between two automatic 
calibrations, limit value 

VT_R8 D 

Optima*.ZO23*.Detector*.Component*.MeasRange*. 
DeltaAmplDriftActual 

Amplification drift between two auto-
matic calibrations, actual value 

VT_R8 D 

Optima*.ZO23*.Detector*.Component*.MeasRange*. 
DeltaAmplDriftLimit 

Amplification drift between two auto-
matic calibrations, limit value 

VT_R8 D 
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LS25 data 

Tag Description Format M/D 

Optima reference no., LS25 no. 

Optima*.LS25*.ModuleName Module name VT_BSTR M 

Optima*.LS25*.UserText User text VT_BSTR M 

Optima*.LS25*.SerialNo Serial number VT_BSTR D 

Optima*.LS25*.FabricationNo Fabrication number VT_BSTR D 

Optima*.LS25*.SoftwareVersion Software version VT_BSTR D 

Optima*.LS25*.Status Status VT_I4 D 

Optima*.LS25*.DetectorCount Detector count VT_I4 D 

Optima*.LS25*.TransmissionValue Measuring value of LS25 transmission VT_R8 M 

Optima*.LS25*.PressureValue Measuring value of pressure VT_R8 M 

Optima*.LS25*.TemperatureValue Measuring value of temperature VT_R8 M 

Optima reference no., LS25 no., detector no. 

Optima*.LS25*.Detector*.Name Detector name VT_BSTR D 

Optima*.LS25*.Detector*.ComponentCount Component count VT_I4 D 

Optima*.LS25*.Detector*.ActiveComponent Active component VT_I4 D 

Optima*.LS25*.Detector*.RawValue Raw value VT_R8 M 

Optima reference no., LS25 no., detector no., component no. 

Optima*.LS25*.Detector*.Component*.Name Component name VT_BSTR M 

Optima*.LS25*.Detector*.Component*.Unit Component unit VT_BSTR M 

Optima*.LS25*.Detector*.Component*.MeasVal Measuring value VT_R8 M 

Optima*.LS25*.Detector*.Component*.RangeLow Measuring range start VT_R8 D 

Optima*.LS25*.Detector*.Component*.RangeHigh Measuring range end VT_R8 D 
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ACF5000 data 

Tag Description Format M/D 
Optima reference no., ACF5000 no. 
Optima*.ACF5000*.FTIRCount FTIR module count VT_I4 D 
Optima*.ACF5000*.FIDAspCount Fidas24 or aspirator module count VT_I4 D 
Optima*.ACF5000*.ZrO2Count ZrO2 module count VT_I4 D 
Optima*.ACF5000*.RegionCount Region count VT_I4 D 
Optima*.ACF5000*.ValidationWheelTempActual Measuring value of validation wheel tem-

perature 
VT_R8 M 

Optima*.ACF5000*.ValidationWheelTempRangeLow Measuring range start of validation 
wheel temperature 

VT_R8 D 

Optima*.ACF5000*.ValidationWheelTempRangeHigh Measuring range end of validation wheel 
temperature 

VT_R8 D 

Optima*.ACF5000*.ElectronicBoxTempActual Measuring value of electronic box tem-
perature 

VT_R8 M 

Optima*.ACF5000*.ElectronicBoxTempRangeLow Measuring range start of electronic box 
temperature 

VT_R8 D 

Optima*.ACF5000*.ElectronicBoxTempRangeHigh Measuring range end of electronic box 
temperature 

VT_R8 D 

Optima*.ACF5000*.CabinetInsideTempActual Measuring value of cabinet inside tem-
perature 

VT_R8 M 

Optima*.ACF5000*.CabinetInsideTempRangeLow Measuring range start of cabinet inside 
temperature 

VT_R8 D 

Optima*.ACF5000*.CabinetInsideTempRangeHigh Measuring range end of cabinet inside 
temperature 

VT_R8 D 

Optima*.ACF5000*.CabinetOutsideTempActual Measuring value of cabinet outside tem-
perature 

VT_R8 M 

Optima*.ACF5000*.CabinetOutsideTempRangeLow Measuring range start of cabinet outside 
temperature 

VT_R8 D 

Optima*.ACF5000*.CabinetOutsideTempRangeHigh Measuring range end of cabinet outside 
temperature 

VT_R8 D 

Optima*.ACF5000*.ProbeHeatingActual Measuring value of probe heating VT_R8 M 
Optima*.ACF5000*.ProbeHeatingControlVariable Control variable of probe heating VT_R8 M 
Optima*.ACF5000*.ProbeHeatingSetpoint Setpoint of probe heating VT_R8 D 
Optima*.ACF5000*.ProbeFilterHeatingActual Measuring value of probe filter heating VT_R8 M 
Optima*.ACF5000*.ProbeFilterHeatingControlVariable Control variable of probe filter heating VT_R8 M 
Optima*.ACF5000*.ProbeFilterHeatingSetpoint Setpoint of probe filter heating VT_R8 D 
Optima*.ACF5000*.SampleGasLineHeatingActual Meas. value of sample gas line heating VT_R8 M 
Optima*.ACF5000*. 
SampleGasLineHeatingControlVariable 

Control variable of sample gas line heat-
ing 

VT_R8 M 

Optima*.ACF5000*.SampleGasLineHeatingSetpoint Setpoint of sample gas line heating VT_R8 D 
Optima*.ACF5000*.IntensityH2O H2O intensity VT_R8 D 
Optima*.ACF5000*.IntensityH2OStatus Status of H2O intensity VT_I4 D 
Optima*.ACF5000*.IntensityCO2 CO2 intensity VT_R8 D 
Optima*.ACF5000*.IntensityCO2Status Status of CO2 intensity VT_I4 D 

Optima reference no., ACF5000 no., FTIR no. 
Optima*.ACF5000*.FTIR*.ModuleName Module name VT_BSTR M 
Optima*.ACF5000*.FTIR*.UserText User text VT_BSTR M 
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Tag Description Format M/D 
Optima*.ACF5000*.FTIR*.SerialNo Serial number VT_BSTR D 
Optima*.ACF5000*.FTIR*.FabricationNo Fabrication number VT_BSTR D 
Optima*.ACF5000*.FTIR*.SoftwareVersion Software version VT_BSTR D 
Optima*.ACF5000*.FTIR*.Status Status VT_I4 D 
Optima*.ACF5000*.FTIR*.DetectorCount Detector count VT_I4 D 

Optima reference no., ACF5000 no., FTIR no., detector no. 
Optima*.ACF5000*.FTIR*.Detector*.Name Detector name VT_BSTR D 
Optima*.ACF5000*.FTIR*.Detector*.ComponentCount Component count VT_I4 D 
Optima*.ACF5000*.FTIR*.Detector*.ActiveComponent Active component VT_I4 D 
Optima*.ACF5000*.FTIR*.Detector*.RawValue Raw value VT_R8 M 

Optima reference no., ACF5000 no., FTIR no., detector no., component no. 
Optima*.ACF5000*.FTIR*.Detector*.Component*.Name Component name VT_BSTR M 
Optima*.ACF5000*.FTIR*.Detector*.Component*.Unit Component unit VT_BSTR M 
Optima*.ACF5000*.FTIR*.Detector*.Component*. 
MeasVal 

Measuring value VT_R8 M 

Optima*.ACF5000*.FTIR*.Detector*.Component*. 
Status 

Status VT_I4 D 

Optima*.ACF5000*.FTIR*.Detector*.Component*. 
RangeLow 

Measuring range start VT_R8 D 

Optima*.ACF5000*.FTIR*.Detector*.Component*. 
RangeHigh 

Measuring range end VT_R8 D 

Optima*.ACF5000*.FTIR*.Detector*.Component*. 
MeasRangeCount 

Measuring range count VT_I4 D 

Optima*.ACF5000*.FTIR*.Detector*.Component*. 
ActiveMeasRange 

Active measuring range VT_I4 D 

Optima*.ACF5000*.FTIR*.Detector*.Component*. 
LowPassNonLinearTimeConstant 

Low-pass non-linear filter, low-pass time 
constant 

VT_R8 D 

Optima*.ACF5000*.FTIR*.Detector*.Component*. 
LowPassNonLinearFilterTimeConstant 

Low-pass non-linear filter, non-linear 
filter low-pass time constant 

VT_R8 D 

Optima*.ACF5000*.FTIR*.Detector*.Component*. 
LowPassNonLinearFilterThreshold 

Low-pass non-linear filter, non-linear 
filter threshold 

VT_R8 D 

Optima reference no., ACF5000 no., Fidas24/aspirator no. 
Optima*.ACF5000*.FIDAsp*.IsFidas24Module TRUE if module is a Fidas24 module VT_BOOL D 
Optima*.ACF5000*.FIDAsp*.IsAspiratorPumpModule TRUE if module is an aspirator pump 

module 
VT_BOOL D 

Optima*.ACF5000*.FIDAsp*.IsAspiratorPumpO2Module TRUE if module is an aspirator pump 
module with O2 

VT_BOOL D 

Optima*.ACF5000*.FIDAsp*.ModuleName Module name VT_BSTR M 
Optima*.ACF5000*.FIDAsp*.UserText User text VT_BSTR M 
Optima*.ACF5000*.FIDAsp*.SerialNo Serial number VT_BSTR D 
Optima*.ACF5000*.FIDAsp*.FabricationNo Fabrication number VT_BSTR D 
Optima*.ACF5000*.FIDAsp*.SoftwareVersion Software version VT_BSTR D 
Optima*.ACF5000*.FIDAsp*.Status Status VT_I4 D 
Optima*.ACF5000*.FIDAsp*.DetectorCount Detector count VT_I4 D 
Optima*.ACF5000*.FIDAsp*.PreampHeatingActual Measuring value VT_R8 M 
Optima*.ACF5000*.FIDAsp*. 
PreampHeatingControlVariable 

Control variable VT_R8 M 

Optima*.ACF5000*.FIDAsp*.PreampHeatingSetpoint Setpoint VT_R8 D 
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Tag Description Format M/D 
Optima*.ACF5000*.FIDAsp*.FlameTempActual Measuring value of flame temperature VT_R8 M 
Optima*.ACF5000*.FIDAsp*.FlameTempRangeLow Measuring range start of flame tempera-

ture 
VT_R8 D 

Optima*.ACF5000*.FIDAsp*.FlameTempRangeHigh Measuring range end of flame tempera-
ture 

VT_R8 D 

Optima*.ACF5000*.FIDAsp*.CombustionAirPressActual Measuring value of combustion air pres-
sure 

VT_R8 M 

Optima*.ACF5000*.FIDAsp*. 
CombustionAirPressControlVariable 

Control variable of combustion air pres-
sure 

VT_R8 M 

Optima*.ACF5000*.FIDAsp*. 
CombustionAirPressSetpoint 

Setpoint of combustion air pressure VT_R8 D 

Optima*.ACF5000*.FIDAsp*. 
CombustionGasPressActual 

Measuring value of combustion gas pres-
sure 

VT_R8 M 

Optima*.ACF5000*.FIDAsp*. 
CombustionGasPressControlVariable 

Control variable of combustion gas pres-
sure 

VT_R8 M 

Optima*.ACF5000*.FIDAsp*. 
CombustionGasPressSetpoint 

Setpoint of combustion gas pressure VT_R8 D 

Optima*.ACF5000*.FIDAsp*.DetectorHeatingActual Measuring value of detector heating VT_R8 M 
Optima*.ACF5000*.FIDAsp*. 
DetectorHeatingControlVariable 

Control variable of detector heating VT_R8 M 

Optima*.ACF5000*.FIDAsp*.DetectorHeatingSetpoint Setpoint of detector heating VT_R8 D 
Optima*.ACF5000*.FIDAsp*.SampleCellHeatingActual Measuring value of sample cell heating VT_R8 M 
Optima*.ACF5000*.FIDAsp*. 
SampleCellHeatingControlVariable 

Control variable of sample cell heating VT_R8 M 

Optima*.ACF5000*.FIDAsp*. 
SampleCellHeatingSetpoint 

Setpoint of sample cell heating VT_R8 D 

Optima*.ACF5000*.FIDAsp*. 
InstrumentAirPreHeatingActual 

Measuring value of instrument air pre-
heating 

VT_R8 M 

Optima*.ACF5000*.FIDAsp*. 
InstrumentAirPreHeatingControlVariable 

Control variable of instrument air pre-
heating 

VT_R8 M 

Optima*.ACF5000*.FIDAsp*. 
InstrumentAirPreHeatingSetpoint 

Setpoint of instrument air pre-heating VT_R8 D 

Optima*.ACF5000*.FIDAsp*. 
SampleGasInletPressActual 

Measuring value of sample gas inlet pres-
sure 

VT_R8 M 

Optima*.ACF5000*.FIDAsp*. 
SampleGasInletPressControlVariable 

Control variable of sample gas inlet pres-
sure 

VT_R8 M 

Optima*.ACF5000*.FIDAsp*. 
SampleGasInletPressSetpoint 

Setpoint of sample gas inlet pressure VT_R8 D 

Optima*.ACF5000*.FIDAsp*. 
SampleGasOutletPressActual 

Measuring value of sample gas outlet 
pressure 

VT_R8 M 

Optima*.ACF5000*.FIDAsp*. 
SampleGasOutletPressControlVariable 

Control variable of sample gas outlet 
pressure 

VT_R8 M 

Optima*.ACF5000*.FIDAsp*. 
SampleGasOutletPressSetpoint 

Setpoint of sample gas outlet pressure VT_R8 D 

Optima*.ACF5000*.FIDAsp*.FlowActual Measuring value of flow detector VT_R8 M 
Optima*.ACF5000*.FIDAsp*.FlowRangeLow Measuring range start of flow detector VT_R8 D 
Optima*.ACF5000*.FIDAsp*.FlowRangeHigh Measuring range end of flow detector VT_R8 D 
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Tag Description Format M/D 
Optima reference no., ACF5000 no., Fidas24/aspirator no., detector no. 

Optima*.ACF5000*.FIDAsp*.Detector*.Name Detector name VT_BSTR D 

Optima*.ACF5000*.FIDAsp*.Detector*. 
ComponentCount 

Component count VT_I4 D 

Optima*.ACF5000*.FIDAsp*.Detector*. 
ActiveComponent 

Active component VT_I4 D 

Optima*.ACF5000*.FIDAsp*.Detector*.RawValue Raw value VT_R8 M 

Optima reference no., ACF5000 no., Fidas24/aspirator no., detector no., component no. 

Optima*.ACF5000*.FIDAsp*.Detector*.Component*. 
Name 

Component name VT_BSTR M 

Optima*.ACF5000*.FIDAsp*.Detector*.Component*. 
Unit 

Component unit VT_BSTR M 

Optima*.ACF5000*.FIDAsp*.Detector*.Component*. 
MeasVal 

Measuring value VT_R8 M 

Optima*.ACF5000*.FIDAsp*.Detector*.Component*. 
Status 

Status VT_I4 D 

Optima*.ACF5000*.FIDAsp*.Detector*.Component*. 
RangeLow 

Measuring range start VT_R8 D 

Optima*.ACF5000*.FIDAsp*.Detector*.Component*. 
RangeHigh 

Measuring range end VT_R8 D 

Optima*.ACF5000*.FIDAsp*.Detector*.Component*. 
MeasRangeCount 

Measuring range count VT_I4 D 

Optima*.ACF5000*.FIDAsp*.Detector*.Component*. 
ActiveMeasRange 

Active measuring range VT_I4 D 

Optima*.ACF5000*.FIDAsp*.Detector*.Component*. 
LowPassNonLinearTimeConstant 

Low-pass non-linear filter, low-pass time 
constant 

VT_R8 D 

Optima*.ACF5000*.FIDAsp*.Detector*.Component*. 
LowPassNonLinearFilterTimeConstant 

Low-pass non-linear filter, non-linear 
filter low-pass time constant 

VT_R8 D 

Optima*.ACF5000*.FIDAsp*.Detector*.Component*. 
LowPassNonLinearFilterThreshold 

Low-pass non-linear filter, non-linear 
filter threshold 

VT_R8 D 

Optima reference no., ACF5000 no., Fidas24/aspirator no., detector no., component no., measuring range no. 

Optima*.ACF5000*.FIDAsp*.Detector*.Component*. 
MeasRange*.OffsetDriftActual 

Cumulative offset drift since the base 
calibration, actual value 

VT_R8 D 

Optima*.ACF5000*.FIDAsp*.Detector*.Component*. 
MeasRange*.OffsetDriftLimit 

Cumulative offset drift since the base 
calibration, limit value 

VT_R8 D 

Optima*.ACF5000*.FIDAsp*.Detector*.Component*. 
MeasRange*.AmplDriftActual 

Cumulative amplification drift since the 
base calibration, actual value 

VT_R8 D 

Optima*.ACF5000*.FIDAsp*.Detector*.Component*. 
MeasRange*.AmplDriftLimit 

Cumulative amplification drift since the 
base calibration, limit value 

VT_R8 D 

Optima*.ACF5000*.FIDAsp*.Detector*.Component*. 
MeasRange*.DeltaOffsetDriftActual 

Offset drift between two automatic cali-
brations, actual value 

VT_R8 D 

Optima*.ACF5000*.FIDAsp*.Detector*.Component*. 
MeasRange*.DeltaOffsetDriftLimit 

Offset drift between two automatic cali-
brations, limit value 

VT_R8 D 

Optima*.ACF5000*.FIDAsp*.Detector*.Component*. 
MeasRange*.DeltaAmplDriftActual 

Amplification drift between two auto-
matic calibrations, actual value 

VT_R8 D 

Optima*.ACF5000*.FIDAsp*.Detector*.Component*. 
MeasRange*.DeltaAmplDriftLimit 

Amplification drift between two auto-
matic calibrations, limit value 

VT_R8 D 
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Tag Description Format M/D 
Optima reference no., ACF5000 no., ZrO2 no. 

Optima*.ACF5000*.ZrO2*.ModuleName Module name VT_BSTR M 

Optima*.ACF5000*.ZrO2*.UserText User text VT_BSTR M 

Optima*.ACF5000*.ZrO2*.SerialNo Serial number VT_BSTR D 

Optima*.ACF5000*.ZrO2*.FabricationNo Fabrication number VT_BSTR D 

Optima*.ACF5000*.ZrO2*.SoftwareVersion Software version VT_BSTR D 

Optima*.ACF5000*.ZrO2*.Status Status VT_I4 D 

Optima*.ACF5000*.ZrO2*.DetectorCount Detector count VT_I4 D 

Optima*.ACF5000*.ZrO2*.AmbientPressActual Measuring value of ambient pressure VT_R8 M 

Optima*.ACF5000*.ZrO2*.AmbientPressRangeLow Measuring range start of ambient pres-
sure 

VT_R8 D 

Optima*.ACF5000*.ZrO2*.AmbientPressRangeHigh Measuring range end of ambient pres-
sure 

VT_R8 D 

Optima reference no., ACF5000 no., ZrO2 no., detector no. 

Optima*.ACF5000*.ZrO2*.Detector*.Name Detector name VT_BSTR D 

Optima*.ACF5000*.ZrO2*.Detector*.ComponentCount Component count VT_I4 D 

Optima*.ACF5000*.ZrO2*.Detector*.ActiveComponent Active component VT_I4 D 

Optima*.ACF5000*.ZrO2*.Detector*.RawValue Raw value VT_R8 M 

Optima reference no., ACF5000 no., ZrO2 no., detector no., component no. 

Optima*.ACF5000*.ZrO2*.Detector*.Component*.Name Component name VT_BSTR M 

Optima*.ACF5000*.ZrO2*.Detector*.Component*.Unit Component unit VT_BSTR M 

Optima*.ACF5000*.ZrO2*.Detector*.Component*. 
MeasVal 

Measuring value VT_R8 M 

Optima*.ACF5000*.ZrO2*.Detector*.Component*. 
Status 

Status VT_I4 D 

Optima*.ACF5000*.ZrO2*.Detector*.Component*. 
RangeLow 

Measuring range start VT_R8 D 

Optima*.ACF5000*.ZrO2*.Detector*.Component*. 
RangeHigh 

Measuring range end VT_R8 D 

Optima*.ACF5000*.ZrO2*.Detector*.Component*. 
MeasRangeCount 

Measuring range count VT_I4 D 

Optima*.ACF5000*.ZrO2*.Detector*.Component*. 
ActiveMeasRange 

Active measuring range VT_I4 D 

Optima*.ACF5000*.ZrO2*.Detector*.Component*. 
LowPassNonLinearTimeConstant 

Low-pass non-linear filter, low-pass time 
constant 

VT_R8 D 

Optima*.ACF5000*.ZrO2*.Detector*.Component*. 
LowPassNonLinearFilterTimeConstant 

Low-pass non-linear filter, non-linear 
filter low-pass time constant 

VT_R8 D 

Optima*.ACF5000*.ZrO2*.Detector*.Component*. 
LowPassNonLinearFilterThreshold 

Low-pass non-linear filter, non-linear 
filter threshold 

VT_R8 D 

Optima reference no., ACF5000 no., ZrO2 no., detector no., component no., measuring range no. 

Optima*.ACF5000*.ZrO2*.Detector*.Component*. 
MeasRange*.OffsetDriftActual 

Cumulative offset drift since the base 
calibration, actual value 

VT_R8 D 

Optima*.ACF5000*.ZrO2*.Detector*.Component*. 
MeasRange*.OffsetDriftLimit 

Cumulative offset drift since the base 
calibration, limit value 

VT_R8 D 

Optima*.ACF5000*.ZrO2*.Detector*.Component*. 
MeasRange*.AmplDriftActual 

Cumulative amplification drift since the 
base calibration, actual value 

VT_R8 D 
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Tag Description Format M/D 
Optima*.ACF5000*.ZrO2*.Detector*.Component*. 
MeasRange*.AmplDriftLimit 

Cumulative amplification drift since the 
base calibration, limit value 

VT_R8 D 

Optima*.ACF5000*.ZrO2*.Detector*.Component*. 
MeasRange*.DeltaOffsetDriftActual 

Offset drift between two automatic cali-
brations, actual value 

VT_R8 D 

Optima*.ACF5000*.ZrO2*.Detector*.Component*. 
MeasRange*.DeltaOffsetDriftLimit 

Offset drift between two automatic cali-
brations, limit value 

VT_R8 D 

Optima*.ACF5000*.ZrO2*.Detector*.Component*. 
MeasRange*.DeltaAmplDriftActual 

Amplification drift between two auto-
matic calibrations, actual value 

VT_R8 D 

Optima*.ACF5000*.ZrO2*.Detector*.Component*. 
MeasRange*.DeltaAmplDriftLimit 

Amplification drift between two auto-
matic calibrations, limit value 

VT_R8 D 

Optima reference no., ACF5000 no., Region no. 

Optima*.ACF5000*.Region*.RangeLow C/I % range low VT_R8 D 

Optima*.ACF5000*.Region*.RangeHigh C/I % range high VT_R8 D 

Optima*.ACF5000*.Region*.InitialIntensity C/I % initial intensity VT_R8 D 

Optima*.ACF5000*.Region*.Intensity C/I % intensity VT_R8 D 

Optima*.ACF5000*.Region*.Status C/I % status VT_I4 D 
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XML description of system messages 

Output of system mes-
sages as XML string 

The system messages are written in an XML string.  

For data interpretation the knowledge of XML is presupposed. 

  
Elements and  
attributes 

Element MessageData This is the topmost element of the XML string and is used 
to structure the messages contained therein. 

Attribute MessageCount The number of existing messages. 

Element Message This is the element for a single message. The number of 
existing entries corresponds to the number of existing 
messages. 

Attribute Idx The continuous number of the message. 

Attribute ID The ID of the message. 

Attribute Type The type of the message. 

Attribute EntryModule A description of the module causing the message. 

Attribute EntryTime The time the message was generated. 

Attribute MessageNo The message number. 

Attribute MessageText The text of the message. The message text is output in the 
same language as it is output on the device. If the error 
text is required in another language, the message number 
must be evaluated. 
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Export tags to a CSV file 

Export of existing tags It is possible to export the existing tags of a connection to a CSV file using  
"AO-OPC Remote Control". The user can save several values in the CSV file in addition 
to the data tag names which are always stored. 

  
Tag export settings In AO-OPC Remote Control, use the menu command "Options → Tag Export Settings" 

to open the dialog for selecting the parameters to be exported. Further parameters 
can be selected here in addition to the OPC tags which are generally exported: Value, 
Time stamp, Quality and Description. 

  
 

 

  
Export tags In AO-OPC Remote Control, use the menu command "File → Export Tags" to open the 

dialog for entering a CSV file name. All tags with their additional parameters which are 
also currently displayed in the list view are exported to this file by selecting "OK". The 
individual values of a line are each separated by a tab stop. 
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